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Disclaimer; Limited Warranty & Limitation of Liability 

Rigel Medical, part of the SEAWARD GROUP guarantees this software package for a period of 1 
(one) year.  The period of warranty will be effective at the day of   delivery. 

 
Although all Seaward Group programs are tested before release, no claim is made concerning     
the accuracy of the software or its associated documentation. The Seaward Group, and distributors 
of the software, cannot assume liability for any loss or damage arising from the use of this program. 
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All rights reserved.  No part of this publication or software may be reproduced in any form or by   
any means, electronic or mechanical, including photocopying, recording, or any information storage 
and retrieval system without the permission in writing from SEAWARD   GROUP. 

 
Due to a policy of continuous development the SEAWARD GROUP reserves the right to alter the 
equipment specification and description outlined in this publication without prior notice and no part 
of this publication shall be deemed to be part of any contract for the equipment unless specifically 
referred to as an inclusion within such c o n t r a c t . 
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License Agreement 
 

This is a legal agreement between you (either an individual or an organisation) and Seaward Electronic Ltd. 
By installing this software you are agreeing to be bound by the terms of this Agreement. If you do not agree 
to the terms of this Agreement, do not install the software and promptly return the software and 
accompanying items to the place you obtained them for a full refund. 

 
SOFTWARE LICENSE 

 
1. GRANT OF LICENSE. Seaward Electronic Ltd. grants you the right to use one copy of the enclosed 

Seaward Electronic Ltd. Software program (the “Software”) on a single computer. The software in “use” 
on a computer includes when it is loaded into temporary memory (i.e. RAM) or installed into permanent 
memory (e.g. hard disk). 

 
2. COPYRIGHT. The software is owned by Seaward Electronic Ltd. and is protected by copyright laws. 

Therefore you must treat the software like any other copyright material (e.g. a book or musical 
recording). You may not copy the written materials accompanying the Software. 

 
3. OTHER RESTRICTIONS. You may not rent or lease the Software. You may not reverse engineer, 

decompile, or disassemble the Software than otherwise provided for by law. 

 
4. USE ON ONE COMPUTER ONLY. This license allows the Software to be installed into the 

permanent memory (hard disk) of only one computer at a time. 

 
5. LIMITED WARRANTY. Seaward Electronic warrants that (a) the software will perform substantially in 

accordance with the accompanying written materials for a period of one year from the date of receipt 
and (b) any hardware accompanying the Software will be free from defects in materials and 
workmanship under normal use and service for a period of 1 (one) year from the date of receipt. Any 
implied warranties on the Software and hardware are limited to 1 (one) year and 1 (one) year 
respectively. 

 
6. CUSTOMER REMEDIES. Seaward Electronics’ entire liability and your exclusive remedy shall be at 

Seaward Electronic’ option, repair or replacement of the Software or hardware that does not meet 
Seaward Electronic’ Limited Warranty and which is returned to Seaward Electronic with a copy of 
your receipt. This Limited Warranty is void if failure of the Software or hardware has resulted from 
accident, abuse or misapplication. Any replacement Software or hardware will be warranted for the 
remainder of the original warranty period. 

 
7. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. In no event shall Seaward Electronic Ltd. be liable 

for any damages whatsoever (including, without limitation, damages for loss of business profits, 
business interruption, loss of business information, or any other pecuniary loss) arising out of the use of 
or inability to use this Seaward Electronic product, even if Seaward Electronic has been advised of 
the possibility of such damages. 

 
8. REGISTRATION. Within seven days of installing the Software you are required to register the Software 

with Seaward Electronic Ltd. By registering you acknowledge that you have read this Agreement and 
understand and agree to be bound by its terms and conditions without exception, deletion or alteration. 
You also agree that this Agreement sets out in full the Agreement between you and Seaward Electronic 
Ltd. which supersede any proposal or prior Agreement, oral or written, and any other communication 
between you and Seaward Electronic relating to the subject this agreement. 

 
9. INDEMNITY. You agree to indemnify Seaward Electronic Ltd. against any loss, damage or expense 

arising out of or in connection with any unauthorised use, reproduction, sale, making available, by you 
of the Software including any loss, damage or expense arising out of the subsequent use of the 
Software by any other person. 

 
10. GOVERNING LAW. This Agreement is governed by the laws of England and Wales. 

 
 
 
 
 
 
 



Med-eBase Version 2.6 Instruction Manual - Revision   1.0     4  

Contents 

Disclaimer; Limited Warranty & Limitation of Liability ......................................... 2 

License Agreement ................................................................................................. 3 

Introduction ............................................................................................................. 6 

1. Installation ............................................................................................... 7 

1.1. Installing Med-eBase ...................................................................................... 7 

1.2. Checking for Software Update ....................................................................... 8 

1.3. Windows 7 Operating Systems (or later) ...................................................... 8 

1.4. Med-eBase Licensing ..................................................................................... 8 

1.5. Online activation ........................................................................................... 10 

1.6. Activate Offline .............................................................................................. 10 

2. Getting Started ....................................................................................... 14 

2.1. Creating a new Med-eBase Database .......................................................... 14 

2.2. Connecting to an existing Med-eBase Database ....................................... 15 

2.3. Importing a Med-eBase Version 1 Database............................................... 16 

2.4. Navigating Med-eBase .................................................................................. 17 

2.5. Data Structure ............................................................................................... 18 

2.6. Language Settings ........................................................................................ 18 

2.7. Activate Additional Devices ......................................................................... 19 

2.8. Creating a new Asset .................................................................................... 19 

3. Asset Details .......................................................................................... 20 

3.1. Context Menus .............................................................................................. 20 

3.2. Deleting Clients, Sites, Locations or Assets .............................................. 21 

3.3. Med-eBase V2 Settings ................................................................................ 21 

3.4. Merging Assets ............................................................................................. 22 

4. Data Transfer ......................................................................................... 23 

4.1. Downloading Data from a Rigel Device ...................................................... 23 

4.1.1. Electrical Safety and Vital Sign Simulators ....................................... 23 

4.1.2. Performance Analyser Uni-Pulse ........................................................ 27 

4.1.3. Performance Analyser Uni-Pulse 400 ................................................. 29 

4.1.4. Performance Analysers Uni-Therm and Multi-Flo ............................. 31 

4.2. Uploading Data from Med-eBase to a Rigel device .................................... 37 

4.2.1. Electrical Safety and Vital Sign Simulators........................................ 37 

4.2.2. Performance Analysers Uni-Therm and Multi-Flo ............................. 38 

5. Asset Details Tabs ................................................................................. 41 

5.1. Test Results Tab ........................................................................................... 41 



Med-eBase Version 2.6 Instruction Manual - Revision   1.0     5  

5.2. Applied Parts Tab for Rigel 288/62353 (+) ................................................... 43 

5.3. Test Sequence Tab ....................................................................................... 43 

5.4. Searching for an Asset ................................................................................. 44 

6. Comparison Alerts ................................................................................. 46 

7. Creating Test Templates ....................................................................... 47 

7.1. Creating a new Global Test Sequence ........................................................ 48 

7.2. Editing a Global Test Sequence .................................................................. 51 

7.3. Duplicate a Global Test Sequence .............................................................. 52 

7.4. Deleting a Global Test Sequence ................................................................ 53 

7.5. Test Templates for the Rigel 288/62353 (+) ................................................. 54 

7.6. Test Templates for the Rigel Uni-Sim ......................................................... 58 

7.7. Test Templates for the Rigel Uni-Therm ..................................................... 62 

7.8. Test Templates for the Rigel Multi-Flo ........................................................ 64 

8. Test Certificates ..................................................................................... 65 

8.1. Med-eBase Multiple Print function .............................................................. 66 

8.2. Changing the Certificate Template .............................................................. 68 

8.3. Inserting a company logo ............................................................................. 69 

8.4. Inserting an electronic signature ................................................................. 70 

8.5. Customising Certificate Templates ............................................................. 71 

8.6. Certificate Template Preference .................................................................. 73 

9. Data Export ............................................................................................ 74 

9.1. Production of an Asset Report ..................................................................... 74 

9.2. Exporting Multi-Flo Results ......................................................................... 76 

10. Remote Control Rigel Multi-Flo ............................................................ 78 

10.1. Gadget Serial ........................................................................................ 78 

10.2. Creating Test Sequences .................................................................... 81 

10.2.1. Create an Asset ID ............................................................................ 81 

10.2.2. Connecting the Multi-Flo to Med-eBase V 2.4 (or above) .............. 81 

10.2.3. Creating a Test sequences............................................................... 83 

10.2.4. Running a Test Sequence ................................................................ 89 

10.3. During Testing ...................................................................................... 91 

10.4. Reviewing Results ................................................................................ 94 

10.5. Exporting Multi-Flo Results ................................................................. 96 

11. Troubleshooting .................................................................................... 98 



Med-eBase Version 2.6 Instruction Manual - Revision   1.0     6 

 

Introduction 
 

First of all thank you for choosing Rigel’s Med-eBase software as your product of choice.  We trust 
this product meets your requirements however, as we value a close partnership with our clients, we 
welcome your feedback in order to improve features, usability and benefits to your organisation and 
that of others. 

 
Med-eBase is a versatile database program aimed to centralise data from biomedical test 
equipment and in particular Rigel’s electrical safety analysers, vital signs simulators and 
performance analysers. 

 
Whether you prefer a local database or centralised network access, Med-eBase can be configured 
and adapted to suit any business criteria. 

 
With Med-eBase you can now download your Rigel testers, analyse data by automatic comparison 
against previous results and create test protocols asset libraries. Use the scheduling and upload 
function to interrogate your database and configure your test devices for fast and effective retesting. 

 
As Rigel’s product range increases, regular product updates are expected and to ensure we can 
improve our products, do let us have your feedback. Please contact us at 
support@rigelmedical.com with your suggestions. 
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1. Installation 
 

1.1. Installing Med-eBase 
 

To install Med-eBase Asset Management software V2, you will need to meet the minimum system 
requirements listed below. 

 
Hardware 

 ❖ IBM compatible 1 GHz or higher  processor ❖ 512 MB of RAM ❖ 350 MB available hard drive  space ❖ Colour monitor with 32-bit colour  capability ❖ CD ROM drive 

Software ❖ Windows XP SP2 or later, Windows  7, 8 or 10 ❖ 32-bit/64-bit  Operating System 

 
Note:   (a) Med-eBase will need to be installed. and the licence activated. by an 

Administrator. 
(b) make sure, before installing, Med-eBase ensure no other applications are 
running. 

 
 

1. Insert the Med-eBase CD (if applicable) into your CD drive and the installation should begin 
automatically. 

 
2. If Med-eBase does not automatically install then open My Computer or Windows Explorer and 

view the CD drive.  Locate and RUN the file setup.exe to begin the installation. 

 
3. If you are using the installer package downloaded from the rigelmedical.com  website,  open  

the Rigel Med-eBase Installer .exe file to begin the installation from: 

 
http://www.rigelmedical.com/rigel-downloads?id=Software%20Download 

 

4. Follow the onscreen instructions to complete the installation. 
 

The language setting can be changed from the installation language once the software is fully 
installed. 

 
Once the program is installed, a shortcut will be provided on your desktop.  Double click the 
shortcut with your mouse to open Med-eBase V2. 

 
Please refer to application note 0037 Installing Med-eBase onto a PC to aid in the installation 
process.   http://www.rigelmedical.com/downloads/0037-Installing-Med-eBase-on-PC.pdf 
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1.2. Checking for Software Update 

Med-eBase software has a built-in feature to automatically check for product updates and will notify 
the user when new features or versions are available. 

 
The automatic update feature ensures that the user can benefit from the latest features and 
functions  without having to actively  search for new updates, giving you peace of mind. 

 
To benefit from the automatic updates, the user must have an internet connection and 
Administrator rights on the PC. Updates can be checked manually by clicking on the HELP button 
in the tool bar and select “check for updates” 

 

 
If an update is available you will be informed. User confirmation is required prior to installation of the 
updates. 

 
 

 
 

1.3. Windows 7 Operating Systems (or later) 
 

Enhanced security settings in Windows 7 require the user to register the product as an 
Administrator. To do so, right click on the Med-eBase icon on the desk top, and select Run as 
administrator. This will ensure that the license codes are written and stored in the Windows 
registry. 

 

 

 
Please refer to application note 0032 Med-eBase V2 with Windows 7 for details of this process.  

 
 
 

1.4. Med-eBase Licensing 
 

When first running Med-eBase the licence activation screen will be displayed. Follow the on-screen 
instructions to activate the 30-day trial or full Med-eBase program. 

 
The Full license of Med-eBase V2.6 Software comes with 1 license as standard. This license 
entitles 1 copy of Med-eBase to be installed on 1 PC with 1 device type unlocked either; 
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❖ Electrical Safety (Rigel 288/62353 / Rigel 288+/62353+) ❖ Sim range (Uni-Sim/BP-Sim/SP-Sim). ❖ Uni-Pulse (and Uni-Pulse 400) ❖ Uni-Therm (and ESA-377/377+) ❖ Multi-Flo 

 
To activate other device types an additional license must be purchased via your Rigel Medical 
supplier. 

 
The 30 day Trial license allows the user full functionality of all device types for a period of 30 days 
from activation. 

 
NOTE: The activation screens may look slightly different depending on the operating system 
 

 

 
 
 
 

To activate a trial version of Med-eBase 

 
Select the Trial Med-eBase option on the initial activation wizard screen (shown above). 

 

 
To activate a Full version of Med-eBase 

 
To activate the full Med-eBase program, input the serial number provided on your copy of Med- 
eBase into the Serial field. 

If you have this in electronic format, you can use the paste icon    to enter the Serial Number 
and then select NEXT. 

 
If you do not have a serial number and have purchased a full license for Med-eBase please   
contact Support@rigelmedical.com indicating the Rigel device requiring Med-eBase, your company 
details and the purchase order number. 

 
Activation continues from this point identically for both Trial and Full Med-eBase licenses and can 
be accessed via online or offline activation. 
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1.5. Online activation 
 

Med-eBase is activated online by default. If an internet connection is not available select the 
Activate Offline option when prompted, and then select NEXT. 

 

 

When continuing with Activate Online follow the on-screen instructions. 
 

The activation wizard will test the internet connection to the activation server. 
 

NOTE: Your IT department may need to assist you with any proxy setting issues 
 

 

1.6. Activate Offline 
 

If Activate Offline is selected please contact Rigel Medical, indicating the Rigel device requiring 
Med-eBase, your company details and if applicable the Main Serial Number. 
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Once the serial number and activation key have been entered select NEXT. 

Enter your contact and company details. 

 
 

 

NOTE: When providing contact details all required fields must be completed with the 
minimum character values for each field shown in the table below. If the NEXT icon is greyed 
out this indicates that a field does not meet the minimum requirement. 

 
Minimum Characters for Med-eBase Activation 

 
During activation the next button will only become available when all validation is satisfied: 
All required fields must be filled in 

 
Field Minimum Length 

Company Details 

Company Name 6 

Address 1 2 

Country 2 

Post Code 5 

Email Address @ and .XX (2 characters) 

Contact Details 

Contact Name 4 
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NOTE: If the postcode does not meet the minimum requirement or the location does not 
have a postcode please enter 5 values 

 
Once completed select NEXT to finalise the activation process and then select   OK. 

 

 
 

For a Trial Version 
 

Once the activation is complete you will be sent a confirmation email with the Main Serial number 
and Activation Key which you will need to enter into the Med-eBase screen shown below. You will 
have access to all device types and functionality of Med-eBase for 30 days from the date of 
activation. 

 
A copy button allows users to copy their serial number and activation key(s) and paste them into the 
required fields from the confirmation email rather than copying and possibly failing to type the 
correct key. 
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For a Full Version 

 
You will have received one activation key for a Rigel device (e.g. Rigel 288). If you have purchased 
additional activation keys which unlock other Rigel device types then the Additional Activation 
Key(s) can be entered into the lower field under the activation key field, one at a time and then 
select ADD to activate each feature. The activated features will be listed in the large text box. 

 
A copy button allows users to copy their serial number and activation key(s) and paste them into the 
required fields from the confirmation email rather than copying and possibly failing to type the 
correct key. 
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2. Getting Started 
 

2.1. Creating a new Med-eBase Database 
 

Select File, Connect to Database using the top menu. 
 

 
 

 
To create a local database using SQLite select New, and then choose a name for your new 
database with the extension .db and select Save. 

 

 
 

Med-eBase allows a choice of database formats: 

 ❖ Local - which is fast, has no server, single user access and no concurrency issues 
 ❖ Remote - which has all of the data stored in a centralised location for access by many 

people concurrently, and can be used with other database tools. 

 
An Example database is held within the install which demonstrates an example of how a database 
can look and function. This feature lets the user see how the assets are laid out and how test results 
and certificate look before creating their own database. 

 



Med-eBase Version 2.6 Instruction Manual - Revision   1.0     15 

 

2.2. Connecting to an existing Med-eBase Database 
 

Select File, Connect to Database using the top menu. 
 

 
 
 

 
Select Open to open an existing SQLite Database. Locate the .db file and select Open. 

 

 
 
 

 

To connect to an MS SQL Server over Open Database Connectivity (ODBC), click on the MS    
SQL (ODBC) tab. The connection details will be issued by your network administrator. 
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2.3. Importing a Med-eBase Version 1 Database 
 

To convert a Version 1 database into Version 2.4. (or above) either SQL Express or SQL Server 
is required. Using either SQL Express or SQL Server the .mdf file on the V1 Database for Med-
eBase must   be mounted. 

 

 
When this has been done Med-eBase will then know what the .mdf file is and be able to read it as   
a database file: 

 

 
1. Mount .mdf in SQL Express /  Server 
2. Start Med-eBase. 
3. Create a new SQLite database or open an existing SQLite database. 
4. Select File and then Import Med-eBase V1 Database. 

 
 

 
 
 

5. Browse for the .mdf file of the V1  database. 
 

 

 
 
 

6. Click on OK and the import process will start. 
7. The Med-eBase V1 Database data will be imported into the Med-eBase V2 Database. 

 
 

NOTE:  SQL Express or SQL Server is required on the local computer to allow importing of   
a Med-eBase V1 Database. The user may need the assistance of their IT department during 
this import. 



Med-eBase Version 2.6 Instruction Manual - Revision   1.0     17 

 

2.4. Navigating Med-eBase 

 
 

 

 

 

The main screen explained: 
 

1. The Browse Assets view - with the Browse tab selected, the tree view shows the Assets in 
the selected database. Assets are organised by Client, Site and Location. The Search tab 
provides a way to only display assets based on a certain criteria such as Name, Description, 
Serial No. and Re-test Date. 

 

 
2. The Asset Table view - this view displays all of the assets under a particular heading in the 

tree view. 

 
 

3. The Asset Details view - this shows the selected asset details, including test results, applied 

part set-up and test sequences. 
 
 
 
 
 
 
 

(2) 

(1) 

(3) 
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2.5. Data Structure 
 

The Med-eBase database is structured around the owner, Known as the Client and the physical 
location of Assets which is divided into Site & Location. 

 

 
 
 
 

A site may include a number of different locations, such as individual wards within a hospital or 
departments within a company. By selecting a Site or Location from within the Browse Assets tree, 
shown above on the left, the Asset Table, on the right, displays all assets in the selected site or 

location. 

 
 

The client name, sites and locations either comes directly from the information entered into the  
Rigel safety testers or can be manually entering into  Med-eBase  and  edited by selecting  the  
asset and entering new details. 

 
 

 

2.6. Language Settings 
 

Med-eBase comes with a number of language options. 
 

To change the language, select Tools, Change Language and select the required language. 
 

 
 

NOTE: There may be different language options, than shown above, during the continuous 
improvement and development of Med-eBase.  
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2.7. Activate Additional Devices 
 

To access the licence screens at a later date, such as to enable other device types after the initial 
activation, once in the Med-eBase software select Tools and then Activate Additional Features… 

 

 

 
To install your Additional Activation Key, enter this in the bottom box and select ADD. This will 
allow access to the features associated with that device type. 

 
A copy button allows users to copy their additional activation key(s) and paste them into the 
required fields. 

 
 

 

2.8. Creating a new Asset 
 

New assets can be created by clicking the Add New Asset button  on the top right hand 
side of the main screen. This will create a blank asset on the Asset Details panel. 

 

 
 

The maximum length of each field is 25 characters. 
 

Asset Name is a mandatory field. 

 
Each field’s dropdown list holds the existing entries associated with this field. 

To save the entries click Apply or discard the entries by clicking Reset. 
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3. Asset Details 
 

The  Asset  details  can  be  obtained  by  clicking  on  the  Asset  in  the  Asset  Table  view. The 
following information is displayed in the Asset Details panel. 

 

 

The following tabs are available in the Asset Details  view: 

 ❖ Asset Details ❖ Test Results ❖ Applied Part configuration (Electrical  Safety) ❖ Test Sequence 
 

Asset Details - This shows the basic description of the Asset. The details entered here make it 

easier to search for the Asset from a larger database. 

 
Test Results - This shows the test result history for that Asset.  From this menu it is also possible 

to print test certificates for any of the previous tests. 
 

Applied Parts - This shows the Applied Part configuration used during the testing of this Asset      

for electrical safety. 
 

Test Sequence - This shows the test sequence and individual test results for this   Asset. 
 

 
 
 

3.1. Context Menus 
 

All icons have a right mouse button action. The following actions can be initiated from the right 
mouse button: 

 
The Asset context menu, from any Asset in the Asset Table view, has the following options: 
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The Asset context menu from an Asset in the Recycled folder has the following menu options: 

 

 
 

 
 

The context menu from Clients, Sites and Locations in the Browse Assets tree view only has the 
Delete option. 

 
 
 

 
 
 
 

 

3.2. Deleting Clients, Sites, Locations or Assets 
 

Clients, Sites, Locations and Assets may be deleted by right-mouse clicking the relevant item and 
selecting Delete, selecting Edit, Delete Asset(s) from the context menu (above), or by selecting  
the Delete icon on the right-hand tool bar. 

 
All deleted assets are placed in the Recycled folder on the Browse Assets tree and can be 
displayed by selecting this folder. These assets can be restored by right clicking on the relevant 
Asset(s) and selecting Restore Assets. Similarly, they can be permanently deleted by selecting 
Delete Assets from this menu. 

 
By holding the CTRL key, multiple assets may be selected and manipulated simultaneously in the 
Asset Table view. 

 
Once the asset is permanently removed from the recycled folder the asset ID, Serial Number etc. 
can be reused on another  Asset. 

 

 
 

3.3. Med-eBase V2 Settings 
 

To open the Med-eBase V2 Settings menu, select Tools, Settings. 

 ❖ File Settings - Tick the Use Native File Dialogs checkbox to enable the use of standard 

Windows dialog boxes for opening and saving files. ❖ Log Settings - In the event of a database issue, these options will enable extra information 

to be included in the debug file for diagnostic purposes.  Use of this option will be advised 

by the Rigel Support team. ❖ Restore Factory Settings - This will remove the Med-eBase registry settings and will 

return Med-eBase to its initial state. Window size and position and last opened database 
will all be reset. 
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3.4. Merging Assets 
 

Conducting tests on one asset on multiple instrument tester types i.e. defibrillator will have an 
electrical safety test using the Rigel 288 (+) and then performance testing using the Uni-Pulse. 

 
If the two set of tests have the same asset ID and same asset trace variable information when 

downloaded into Med-eBase the tests will merge into one asset as indicated in the image below. 
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4. Data Transfer 
 

4.1. Downloading Data from a Rigel Device 
 

The method to download data from the Rigel devices is dependent on which Rigel product you 
are using. The methods are divided for: 

 ❖ Electrical Safety Analysers (288 (+), 62353 (+)), and Vital Signs Simulators (Uni- Sim ,     
BP Sim and SP-Sim) ❖ Performance Analyser (Uni-Pulse, Uni-Pulse 400) ❖ Performance Analysers (377, 377+, Uni-Therm, Uni-Pulse and   Multi-Flo) 

 
Please refer to instrument manuals and / or additional application notes for help to aid in the 
download process. 

 

 

4.1.1. Electrical Safety and Vital Sign Simulators 
 

Electrical Safety (288 (+) and 62353 (+)) and Vital Sign Simulators (Uni-Sim, BP-Sim and SP-     
Sim) use the same method of downloading data from the Rigel devices into Med-eBase. 

 

Results 

 
Downloads can be selected from the Download option in the Tools menu or by using the Download 
icon on the taskbar. 
 
 

 

 

After selecting the Download option, the Download from Tester dialogue box will be displayed. 
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Select the relevant Instrument Type from the drop down list. 

 
Ensure you have the correct Baud Rate (the default is 57600) and COM Port selected. The COM 

port is defined by your serial or Bluetooth connection. For a standard data cable connection 
(RS232) this will usually be COM1. 

 
If you do not see the correct COM Port displayed in the drop down menu, select Re-Scan COM 
Ports to refresh the available COM Port list. 

 
Select OK to begin the download from the software side. 

 

 

The software will stay in the download screen while the Rigel device is set up to transfer data. 
 

The download is initiated by starting the download on the Rigel tester. Instructions on how to do this 
will be included in the Instruction Manual for each Rigel device. 

 
You will need to enter the Data Menu and select download to PC and the format is Rigel - SSS. 

Once the download has started, a progress bar will indicate downloading on Med-eBase. 

Upon completion of the download, the download window will close and the Download Report will   
be displayed on Med-eBase. 

 

 

 

 
NOTE: For detailed instructions on how to connect your Rigel device for Data Transfer, 
please see the instruction manual or application note for your device.  
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Test Sequences 
 

Test Sequence can be created on Rigel devices and then downloaded into the Med-eBase 
software as a global test sequence. 

 
Download can be started from the Download option in the Tools menu or by using the Download 
icon on the taskbar. 

 

 

After selecting the Download option, the Download from Tester dialogue box will be displayed. 

Select the relevant Instrument Type from the drop down list. 

NOTE: For detailed instructions on how to connect your Rigel device for Data Transfer, 
please see the instrument instruction manual or application note for your device.  

 
 

 

 

Select the relevant Instrument Type from the drop down list. 

 
Ensure you have the correct Baud Rate (the default is 57600) and COM Port selected. The COM 

port is defined by your serial or Bluetooth connection. For a standard data cable connection 

(RS232) this will usually be COM1. 
 

If you do not see the correct COM Port displayed in the drop down menu, select Re-Scan COM 
Ports to refresh the available COM Port list. 

 
Select OK to begin the download from the software side. 
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The software will stay in the download screen while the Rigel device is set up to transfer data. 

 
The download is initiated by starting the download on the Rigel tester. Instructions on how to do 
this will be included in the Instruction Manual or application note for each Rigel device. 

 
You will need to enter the Data Menu and select download to PC to the format as Test Sequences. 

 
Once the download has started, a progress bar will indicate downloading on Med-eBase. 

 
Upon completion of the download, the download window will close and the Download Report will   

be displayed on Med-eBase. 
 

 

 

 

The downloaded sequences can be viewed in Med-eBase in Tools and then Global Test 

Sequence or the  icon on the top left hand side of the Med-eBase screen. 

 

From this menu the test sequence can be viewed, edited and uploaded back into a Rigel 
Performance analyser (does not work with all analysers, refer to manuals / application notes). 

 

 
 

 
Please refer to application note 0038 Downloading from Rigel devices to Med-eBase to aid in the 
download process. 
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4.1.2. Performance Analyser Uni-Pulse 
 

Downloading Results can be started from the Download option in the Tools menu or by using the 

 icon on the taskbar. 
 

 

 

 
 

After selecting the Download option, the Download from Tester dialogue box will be displayed. 
 
 

 

  
 
 

 

Select the relevant Instrument Type from the drop down list. 

 
Ensure you have the correct Baud Rate (the default is 57600) and COM Port selected. For the Uni-

Pulse the COM port is indicated as a USB Serial Port connection. 
 

If you do not see the correct COM Port displayed in the drop down menu, select Re-Scan COM 
Ports to refresh the available COM Port list. 

 
Select OK to begin the download from the software side. 
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The software will stay in the download screen while the Rigel device is set up to transfer data. 

 
The download is initiated by starting the download on the Rigel tester. Instructions on how to do 
this will be included in the Instruction Manual for each Rigel device. 

 
You will need to enter the Data Menu and search for the required results. Select Download to PC 
and then either Download selected item? or Download all search items? 

 
 
 

NOTE: Med-eBase Data Transfer can only be conducted via USB for the Uni-Pulse. 

 
During the download a progress bar appears on both Med-eBase and the Uni-Pulse. 
 
 
 

 
 

 

 

When the download is complete and summary box appears on Med-eBase to enable the user to 
view what has been downloaded successfully. 

 
 
 

 
 

 
 

NOTE: For detailed instructions on how to connect your Rigel device for Data Transfer, 
please see the instruction manual. The download is always initiated by the Rigel tester. 

 
Also see application note 0045 Downloading from the Rigel Uni-Pulse to Med-eBase to aid in the 
download process. 
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4.1.3. Performance Analyser Uni-Pulse 400  
 

 
The download is initiated by Med-eBase, however, the Uni-Pulse 400 needs to be set-up first. 
Instructions on how to do this will be included in the Instruction Manual and / or corresponding 
Application note for each Rigel device. 

 
On the instrument, you will need to enter the Data Menu (Select data) and search for the required 

results. Select the Download to PC icon  and then either Download selected items? or 
Download all search items? The Uni-Pulse 400 will display a Sending screen until the Med-
eBase begins the download.  

 
NOTE: Med-eBase Data Transfer can only be conducted via USB for the Uni-Pulse 400. 

 
 

Downloading results can be started from the Download option in the Tools menu or by using the  

 icon on the taskbar. 
 
 

 
 

After selecting the Download option, the Download from Tester dialogue box will be displayed. 
 
 

  
 

Select the relevant Instrument Type (Rigel Uni-Pulse 400) from the drop down list. 
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Ensure you have the correct COM Port selected. For the Uni-Pulse 400 the COM port is indicated 

as a USB Serial Port connection. 

 
If you do not see the correct COM Port displayed in the drop down menu, select Re-Scan COM 
Ports to refresh the available COM Port list. 

 
Note: the UP 400 Clock using computer time can be used to set the time on the Uni-Pulse 
400 if required.  

 
Select OK to begin the download from the instrument. 
 

 
 

During the download a progress bar appears on both Med-eBase and the Uni-Pulse 400 
 
 

 
 

 

 

When the download is complete this is indicated on the Uni-Pulse 400 and Download Report 
appears on Med-eBase to enable the user to view what has been downloaded successfully and 
the status of these data.  

 
 

 
 

 
 

NOTE: For detailed instructions on how to connect your Rigel device for Data Transfer, 
please see the instruction manual.  

 
Also see application note 0074 Downloading from the Rigel Uni-Pulse 400 to Med-eBase 
(version 2.6) to aid in the download process. 
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4.1.4. Performance Analysers Uni-Therm and Multi-Flo 
 

To transfer data from the Uni-Therm and Multi-Flo to Med-eBase on the Rigel device go to Menu 
and then Data and Data Transfer. This will take the user to the Data Transfer Screen 

 
NOTE: For detailed instructions on how to connect your Rigel device for Data Transfer, 
please see the instruction manual for that device.  

 
In the Data Transfer Menu the user must select which PORT for data transfer and the data format 
type using OPERATION required for the necessary data transfer. 

 
OPERATION options are: 

 ❖ Export Results ❖ Export Test Sequences ❖ Export CSV ❖ Import Results ❖ Import Test Sequences 

PORT options are: ❖ USB Cable ❖ USB Memory Stick ❖ Bluetooth (Multi-Flo only) 

 
Downloaded files can then be stored, transferred between Rigel devices of the same instrument 
type, PCs or to colleagues. It also is useful with any technical enquiries if the files can be sent with 
the enquiry. 

 

Results 
 

When downloading results into Med-eBase the Rigel device will act as a REMOVABLE DISC data 
storage device. The data file can be copied from the drive that appears in explorer or from the 
memory stick directly into Med-eBase. 

 
NOTE: When using Med-eBase, the export of data will commence from the software once   
the Rigel device is in the TRANSFER READY state. 

 
Start the download from the Rigel tester by pressing START F4. A Transfer Ready indication 
message appears on the Rigel unit with OK to select ONLY ONCE the transfer is complete from   
the PC. 

 
NOTE: When using a USB memory stick the stick needs to be inserted into the Rigel device 
before selecting START F4 on the Data Transfer screen. 
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Download can be started from the Download option in the Tools menu or by using the 
Download icon on the taskbar. 

 

 

After selecting the Download option, the Download from Tester dialogue box will be displayed. 

Chose the correct instrument type and then select the file transfer icon     

 

  
 

 
 

Then the user must select the removal disc which is associated with the Rigel tester (for example 
removal disk E:) to allow the test results to be transferred from the Uni-Therm or Multi-Flo. 

 
When downloading files from the Rigel Uni-Therm or Multi-Flo the latest file will contain all previous 
Sequences stored on the Rigel device and therefore only the last file needs to be used when 
transferring files between the Rigel device and Med-eBase.  Select the appropriate file which should 
be in a format: 

 
Results_DATE_TIME.sss in Format DDMMYYY and hhmmss 

 
Then select OK. The file name should appear in the file transfer window and then select OK to 
transfer into Med-eBase. 
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A download report will appear when the transfer is complete to indicate what has been transferred. 

The downloaded results can be viewed in Med-eBase by looking for the Asset ID or date of test. 

 

 

 

 

 
 

NOTE: If other tests e.g. electrical safety has been performed on the same device and 
downloaded into Med-eBase, the Performance analyser test results can be merged into the 
same Asset ID provided that the asset trace details are identical E.g. Only the Asset ID is 
entered into the Asset details window. See chapter 3 for further information. 
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Test Sequences 
 

Test Sequence can be created on the Rigel devices and then downloaded into the Med-eBase 
software as a global test sequence. 

 
From the data transfer screen select Start and connect the USB memory stick or cable. 

 
NOTE: For detailed instructions on how to connect your Rigel device for Data Transfer, 
please see the instruction manual for that device or corresponding application note.  
Download can be started from the Download option in the Tools menu or by using the Download 
icon on the taskbar. 

 

 
 

After selecting the Download option, the Download from Tester dialogue box will be displayed. 

Chose the correct instrument type and then select the file transfer icon     

 

  
 
 

Then the user must select the removal disc which is associated with the Rigel tester (for example 
removal disk E:) to allow the test results to be transferred from the Uni-Therm or Multi-Flo. 

 
Select the appropriate file which should be in a format: 

 
Sequences__DATE_TIME.sss in Format DDMMYYY and hhmmss 

 
Then select OK. The file name should appear in the file transfer window and then select OK to 
transfer into Med-eBase 
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A download report will appear when the transfer is complete to indicate what has been transferred. 

 
 

 
 
 
 

The downloaded sequences can be viewed in Med-eBase in Tools and then Global Test Sequence 

or the  icon on the top left hand side of the Med-eBase screen 

From this menu the test sequence can be viewed, edited and uploaded back into a Rigel 
Performance analyser. 
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When downloading files from the Rigel Uni-Therm or Multi-Flo the latest file will  contain  all  
previous Sequences stored on the Rigel device and therefore only the last file needs to be used 
when transferring files between the Rigel device and   Med-eBase. 

 
 

Sequence files should be in format Sequences_DATE_TIME.sss in Format DDMMYYY and 

hhmmss 

 
 
Please refer to application note 0048 Downloading from the Rigel Uni-Therm and 377+ or 0049 
Uploading and downloading Test Sequences from Uni-Therm and Med-eBase to aid in these 

processes. 
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4.2. Uploading Data from Med-eBase to a Rigel device 
 

Test sequences can be uploaded from Med-eBase into some Rigel devices, please check the 
instruction manual or application note to confirm this.  

 
NOTE: Sequences can only be uploaded to the same specific instrument test type there are 
associated with e.g. electrical safety test only to a Rigel 288 (+) or Rigel 62353 (+) only. 

 

 

4.2.1. Electrical Safety and Vital Sign Simulators 
 

Electrical Safety (288 (+) and 62353 (+)) and Vital Sign Simulators (Uni-Sim, BP-Sim and SP-     
Sim) use the same method of uploading test sequences from Med-eBase into the Rigel devices. 

 
Sequence which have been created on Med-eBase as a Global Test Sequence or transferred from 
another Rigel device can then be uploaded into a Rigel electrical safety tester or vital signs 
simulator from Med-eBase. 

 
On the Rigel device select OK from the Data Transfer screen to upload. 

 
The Import Complete screen should appear to indicate that the import is complete. 

 
Go into the Global Test Sequence menu on Med-eBase from Tools and then Global Test 

Sequence or the  icon on the top left hand side of the Med-eBase screen. 

Highlight the test sequence(s) that are required to be uploaded and select UPLOAD from the right 
hand side of the screen. 

 
NOTE: Multiple sequences can be uploaded simultaneously by holding CTRL and the 
selecting multiple sequences required. However they must all be the same instrument type. 
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The upload global test sequence to test dialog box will appear and the user must confirm the 
Instrument type, correct Baud Rate and COM Port setting for the Data Transfer. Select OK to begin 
the transfer. 

 
 

 

4.2.2. Performance Analysers Uni-Therm and Multi-Flo 
 

The Rigel Uni-Therm and Multi-Flo use the same method of uploading test sequences from Med- 
eBase into the Rigel devices. 

 
Connect a USB memory stick or cable to the Rigel device. Enter the data transfer screen and select 
the required OPERATION and PORT. To upload the operation needs to be IMPORT 

 
NOTE: For detailed instructions on how to connect your Rigel device for Data Transfer, 
please see the instruction manual that accompanied your device. The download is always 
initiated by the Rigel tester. 

 

 
 

Sequences which have been created on Med-eBase as a Global Test Sequence or transferred from 
another Rigel device can then be uploaded into a Uni-Therm or Multi-Flo from Med-eBase. 

 
On the Rigel device select OK from the Data Transfer screen to upload. 

 
The Import Complete screen should appear to indicate that the import is complete. 

 
Go into the Global Test Sequence menu on Med-eBase from Tools and then Global Test Sequence 

or the icon on the top left hand side of the Med-eBase screen. 

Highlight the test sequence(s) that are required to be uploaded and select UPLOAD from the right 
hand side of the screen. 
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NOTE: Multiple sequences can be uploaded simultaneously by holding CTRL and selecting 
the multiple sequences required. However they must all be the same instrument type. 
 

 
 

The upload global test sequence menu will appear and the user must indicate the instrument     

type. Then select the file transfer  . 

 
 
 

 

Then the user must select the removal disc which is the Rigel device  memory  (for  example 
removal disk E:) to allow the test sequence to be saved onto the Uni-Therm or Multi-Flo. 
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The file must be named in the format Sequences_DATE_TIME.sss in Format DDMMYYY and 

hhmmss 
 

 

 
 
Then select OK to upload the sequence. 

 
Go back onto the Rigel device and select OK from the Data Transfer screen, 

 
The Import Complete screen should appear to indicate that the import is complete. 

 
Please refer to application note 0049 Uploading and downloading Test Sequences from Uni- 
Therm and Med-eBase to aid in this process. 
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5. Asset Details Tabs 
 

5.1. Test Results Tab 
 

From the Asset Details panel, select the Test Results tab. This will display the Test Result 

history for that Asset. 
 

 
Each row of the table in the Test Results tab refers to a complete result set. 

 

 ❖ Use the Results button to display the individual Test Results for each test. 
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A green flag indicates the test result is a pass. The blue flag indicates the result is for information 
only.  A red cross is a fail.  Click on the Plus symbol to expand the test result information. 

 
Note:  Any additional user comments can be entered in the Comments field. These comments   
will appear on the test certificate. 

 ❖ Use the Print Certificate button to create the test certificate for the highlighted test result. 
 ❖ Use the Test Sequence button to view the Test Sequence used for this test. 
 

 ❖ Use the Applied Parts button to display the Applied Part configuration for this test when 

testing using the Rigel 288/62353 (+). 
 

 ❖ Use the Delete key to permanently delete a highlighted test result. 
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5.2. Applied Parts Tab for Rigel 288/62353 (+) 
 

The Applied Part tab displays the settings of the patient connections and applied parts for electrical 
safety testing using the Rigel 288/62353 (+). Each new Applied Part type has a colour code so that 
it can be distinguished from other Applied Part types in the Connections diagram. 

 

 

 
 

The Applied Parts can be set-up for new Assets using this tab. For previous tests, the Applied Part 
fields are for information only and cannot be edited. 

 

 

 
 

 

5.3. Test Sequence Tab 
 

The Test Sequence tab displays the test sequence and individual test settings for this Asset. From 

this screen you can customise the test sequence associated with this Asset. 
 
 

 

 

Select the Add button to add a test above the selected line. 
Select Delete to remove the selected line from the Test Sequence.  
Select Import to insert a Global Test Sequence into the Test Sequence. 

Select Move Up/Move Down to move the selected test up or Down the Test Sequence. 
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Use the Plus symbol to expand and view the details of an individual test. 
 

 
 

 
 

Each asset has an editable test sequence for each instrument type. This can be accessed via the 
Instrument Type drop down menu. 

 

 

5.4. Searching for an Asset 
 

Med-eBase contains a search facility to quickly find an Asset within the database. This can be 
accessed either by clicking on the Search icon on the top menu bar, or by selecting the Search   
tab in the Browse Assets window. 
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Enter the relevant Search criteria to filter the search results. 

The results will be shown in the Asset Table view panel. 

More than one search criteria may be entered in order to narrow down the results even further. 
 

Filtered search and finding assets in Med-eBase can be done by using the wildcard ‘*’ in the search 
field. This will allow for various combinations to be searched for. For example to search for an asset  
ID which has ‘234’ in the middle of  its name you would enter into the Asset ID Search  field ‘*234’. 
All assets with 234 in their name will be displayed. The position of the * indicate what the software 
will search for: 

 ❖ *123 will look for assets with values before  123 
 ❖ 123* will look for assets which start  123 
 ❖ 1*3 will look for assets with 1 and 3 with some values in   between. 
 

 
To switch back to the Browse Assets view, select the Browse tab at the bottom of the window. 
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6. Comparison Alerts 
 

The built-in Comparison Alerts feature can be activated to automatically warn users when test 

result values have deviated from a user-definable criteria or value. This provides peace of mind and 
avoids the user having to manually analyse their data. Test values can drift over time and whilst the 
latest values might still meet the PASS / FAIL criteria, a significant drift from previous or typical 
values could indicate a future problem or failure. Comparing data, will give you the assurance that 
your current downloaded data meets your expectation. 

 

Select Tools, Comparison Alerts.  This will open the Comparison Alerts window. 
 

 

 
 

Specify a percentage or amount results change and Med-eBase will display assets where results 
vary accordingly. 

 
 

 
Select Find Alerts to list all results sets that contain at least one result alert. Select Yes to view   
the Assets. To remove all active alerts, select Remove Alerts. 

 

 
 

If any results are identified by the Comparison Alerts, then they will be identified with a warning 

symbol for user attention. 
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7. Creating Test Templates 
 

Med-eBase contains a function to create your own custom Test Sequence which can be uploaded 
from Med-eBase to your Rigel device. 

 
This function allows you to plan your Test Sequence while using your PC, as an alternative to 
creating the Test Sequence using your Rigel device. 

 
Select Tools, Global Test Sequences or the global test sequence icon on the task bar. 

 
 
 
 

 

 

This will open the Global Test Sequences window. 
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7.1. Creating a new Global Test Sequence 
 

To create a new Global Test Sequence, select New. This will open a blank Test Sequence (note this 
function is not applicable to all instruments). 

 

 
 

Enter the Name for your new Global Test Sequence. This should be something that is recognisable 

to yourself so you can easily identify the Global Test Sequence once it has been uploaded to your 

device. 
 

Select the Instrument Type and Equipment Class for Rigel 288 (+) ONLY from the drop down 

menu. This will dictate which individual tests sequence elements are available for this Global Test 
Sequence. 

 
 

 

 
To add a test, click Add 
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This will display the tests that re available for your device. Highlight the appropriate Test Sequence 
Element and select OK. 

 
The selected Test Sequence Element will now appear as part of your new Global Test Sequence. 
You now have the option to edit the test parameters by selecting the + icon at the end of each 
individual test to open the test options. This allows you to change limits (if required), timings and 
number of tests etc. 

 
 

 
To insert the Test Sequence Elements from another Global Test Sequence into your new Global 
Test Sequence, select Import. This will give you the option of importing an existing Test Sequence 
Element. 
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Highlight the Global Test Sequence and press the Select button. 

 
 

 
 

NOTE: The imported sequence must be the same instrument type. 

 
To delete an individual Test Sequence Element from your Global Test Sequence, highlight the 
individual Test Sequence Element and select Delete. 

 
To move an individual Test Sequence Element up or down the Global Test Sequence, highlight    
the individual Test Sequence Element and select Move Up/Move Down. 
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Select OK to save your Global Test Sequence. 

 
You will be redirected back to the Global Test Sequence Menu where you ‘New’ sequence 

should be located and is ready to be uploaded. 
 

 

7.2. Editing a Global Test Sequence 
 

To edit a Global Test Sequence, highlight the Test Sequence and select Edit. 
 

 
This will open the Global Test Sequence screen so that you can edit, add or remove any of the 
individual Test Sequence Elements in this Global Test Sequence. 
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Click OK to save the changes or Cancel to exit without   saving. 
 

 

7.3. Duplicate a Global Test Sequence 
 

To copy a Global Test Sequence, highlight the test sequence and select Duplicate. This will allow 

the user to copy an existing global test sequence. The new sequence will be assigned the name of 
the original sequence with an [X] where is X is the number of iterations with the same name. Once 
the sequence has been duplicated the user can then rename the sequence and edit the tests within 
the new sequence. 
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7.4. Deleting a Global Test Sequence 
 

To delete a Global Test Sequence, highlight the test sequence and select Delete. 

 
Note: You will not be prompted for confirmation. The Global Test Sequence cannot be recovered 
once deleted. 
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7.5. Test Templates for the Rigel 288/62353 (+) 
 

Templates can be created on Med-eBase for specific makes and models of devices to enable   
users and faster testing. The templates can be uploaded onto the Rigel 288 (+) and then the user 
can enter the device’s serial number and run the test without requiring entering any other details   
as they are linked to the  template. 

 
Equipment required 

 ❖ PC with Med-eBase software ❖ Rigel 288 (+) firmware version 5.00 or higher ❖ Required test sequence/user manuals for devices ❖ Bluetooth or serial communication between PC and Rigel 288 (+) 

Creating the Template using  Med-eBase 

Firstly, the template needs to be created in Med-eBase. When Med-eBase is opened select either 

Edit and then Add New Asset or the icon on the right hand side of the screen. 

 

On the Asset details tab the Asset Name and Equipment class need to be entered. The Asset 
Name should be the name for the template e.g. 1BF1 or 12 lead ECG. The select Apply. 

 
The description may also be filled in to describe the applied parts. All other fields are device specific 
and can therefore be added when the template is on the Rigel 288 (+) or after the results are 
downloaded back into Med-eBase after the testing is complete. 

 
NOTE: The Asset ID field on the Rigel 288 (+) is case sensitive and therefore it is advised to 
keep names simple and to one case style. 

 

 

On the Applied Parts tab the Applied Parts need to be added by selecting the Add icon on the right 
hand side of the screen. 
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Once an Applied Part has been added double click on the required fields to change the Name, 
Connection Class and Number of Connections. E.g. For a 12 Lead ECG machine there are 10 CF 
APs. For defibrillators you will need to add another AP as defibrillators have both CF and BF APs;   
2 BF for the paddles and 3 CF for 3 Lead ECG. Then select   Apply. 

 

 
On the Test Sequence tab make sure that the Instrument Type is Rigel 288/62353 (+). The test 
sequence to be performed needs to be added or imported in this tab. 

 

 

Global test sequences can be imported using the Import… icon which will open the global test 
sequence menu. The appropriate test sequence can be highlighted and then Select to import the 
sequences into the Asset Template. 
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Alternatively tests can be added to create a sequence using the Add… icon. Move down, Move Up 
and Delete allows the user to organise the test sequence as desired. 

 
NOTE: Holding down Ctrl when selecting multiple tests allows them to be added simultaneously. 
The tests will be added in the order they were select and can therefore may creating a test 
sequence easier 

 

 
The Name selected in the Info field will be the test name given on PDF and certificates once the  
test results are downloaded. E.g. 60601 Class 1 or 12 lead ECG class 1. 

 
When complete select Apply to save changes.  Upload the template onto the Rigel 288 (+) 

 
NOTE: This feature is only compatible with Rigel 288 (+) devices that have firmware Version 
5 and higher. 

 
Please see application note 0029 on how to upgrade Rigel 288 (+) Firmware for this feature to be 
available. 

 

Firstly ensure that the PC and Rigel 288 (+) are connected either via RS 232 cable or Bluetooth. 

Go to F4 > Data Transfer> Upload from PC> F4 tick to confirm 

On Med-eBase select the Asset Template so that is it highlighted. Alternatively hold down Ctrl to 
add multiple assets or Ctrl A to select all. 
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Right click and select upload or select the upload icon        from the right hand side of the screen    
or go to Tools> Upload. 

 

 
 
 

 

Select the correct Instrument Type from the drop down list. The Default baud rate for the Rigel 288 
(+) is 57600. Select the correct COM port which is the Bluetooth connection (you may need to look 
at your Bluetooth properties to check the correct COM port) or COM 1 if using a RS 232 serial 
cable. 

 
Select Ok and once the Bluetooth icon appears in the right corner of the Rigel 288 (+) select Ok     
to start the upload. 
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7.6. Test Templates for the Rigel Uni-Sim 

To create a test sequence in Med-eBase select the Global Test Sequence icon  or select 
Tools and then Global Test Sequence… 

 
Select New 

 

 

Enter the sequence name and also the instrument type. 
 

NOTE: Test sequences are for one instrument type only and therefore Med-eBase will not 
allow the user to mix tests from different Rigel devices (e.g. electrical safety and Vital Sign 
Simulations). 

 
Select Add to insert a test or import to import an already created global test sequence. For the Uni-

Sim test option are shown in the image below. 
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The user can select multiple tests by holding ctrl when selecting and the order of selection is 
remembered in the sequence when OK is selected. 

 

 
 

Select the Expand  on each individual test to change the test setting and during of test in the 
start all tests f ield. 

 

 

 
After each group of simulations the start all tests must be inserted so that each simulation or 
change of settings has a set time for the Uni-Sim to recognise. 

 

 

 
Once the test sequence is complete select OK. 

 
Please refer to application note 0057 Creating Test Sequences for Rigel Uni-Sim for further details 
of this process. 
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Creating and uploading ‘O Curves’ into  Med-eBase 
 

To add an ‘O Curve’ onto the Med-eBase V2 software you will need to add the ‘O Curve’ to a 
folder structure which is location outside of the Med-eBase   program. 

 
For Windows XP: Go to C:\Documents and Settings\All Users\Application Data\Rigel\Med-eBase 
V2\OCurves 

 
For Windows 7: Go to C:\ProgramData\Rigel\Med-eBase V2\OCurves 

 

 
NOTE: Program Data and Application Data may be hidden folders.  
 

 

The original csv file used to download the ‘O Curve’ onto the Uni/BP Sim needs to be altered by 
erasing lines 1 to 4. 

 
The CSV file needs to be saved in the follow folder structure which is critical for loading ‘O Curves’ 
onto Med-eBase: 

 
<O Curves> 

<Monitor Type name> e.g. Datascope Passport 2. These folder names will be shown in   
the Monitor Type drop down list in  Med-eBase 

<Adult> 
<Infant> These folders will contain the csv file for Adult or Infant   curves 

<CSV files> Each curve should be saved using the format of Systolic and 
Diastolic values as 3 digits e.g.  080_040.csv. 

 
Re-open Med-eBase V2 and click on Tools, then Global Test Sequences and then New. 

Then select BP/Uni Sim and enter the name of the new test sequence. 

Select Add… then select ‘NIBP Test Setting’, click on the + and there will be a drop down list in 

Monitor Type field where you can select your ‘O Curve’. 

Then in the Adult/Infant field select the type of patient and the chose the Systolic/Diastolic field to 

select the exact ‘O Curve’ you want to add to the test sequence. 

 
 

 

 

Please refer to application note 0040 Creating and uploading ‘O Curves’ on Uni-Sim and Med- 
eBase for instructions on how to create O curve and further information on this feature. 
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Uploading ‘R Curves’ into  Med-eBase 
 

Manufacturers of SP02 monitors all use different algorithms to determine the R curves.  By creating 
a custom ‘R Curve’ for a particular monitor or manufacturer types the UNI-SIM or SP-Sim can be 
made to match the SP02 Monitor more accurately. 

 
The purpose of this document is to provide information on how to create ‘R Curves’ for an SP02 
monitor and add them to part of a test sequence within Med-eBase. 

 
NOTE: These ‘R Curves’ are for use with the optical finger adapter box only 

 
Please refer to application note 0061 Creating and uploading ‘R Curves’ on Uni-Sim and Med- 
eBase for steps on how to create R Curves and further information on this feature. 

 
We strongly advise that the ‘R Curves’ are inserted into Med-eBase V2.4.1 and above R Curves  
data folder to enable users to create test sequences using the software which can then be uploaded 
to the  UNI/SP-Sim. 

 
The ‘R Curve’ data folder can be found in one of the following locations which Med-eBase has been 
installed on. 

 
For Windows XP: 

 
C:\Documents and Settings\All Users\Application Data\Rigel\Med-eBase V2\RCurves 

For Windows 7: 

C:\ProgramData\Rigel\Med-eBase V2\RCurves 

 

NOTE: Program Data and Application Data may be hidden folders.  

 
 
 
 
 

Creating Test Template using R  Curves 
 

Open Med-eBase and select Tools > Global Test Sequences > New. 

Then select SP/Uni Sim and enter the name of the new test   sequence. 

Add… then select ‘SP02 Test Setting’, click on the + and there will be a drop down list in Monitor 
Type field where you can select your ‘R  Curve’. 
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Any errors which have been detected in an R curve script file will be displayed in a dialogue box 
and the Curve will not be included in the drop down list. This was included so any errors can be 
caught with custom R curves which are user created. 

 

 

 
 
 
 

Editing existing Test sequences 
 

Existing test sequences can be downloaded from the UNI/SP-Sim into Med-eBase and will include   
a custom or existing R Curve data. If the data is a custom R curve which Med-eBase does not   
have in its R curve data folder, the R curve name from the test sequence will be included in the  
drop down list previously shown until another curve is   selected. 

 
Therefore it is strongly advises that all R Curves are not only stored within the R Curve data 
folder for Med-eBase but also on the UNI-SP-Sim itself to allow test sequences to be easily 
created and transferred between the Rigel unit and the   software. 

 
 

 

7.7. Test Templates for the Rigel Uni-Therm 
 

To create a test sequence for the Uni-Therm in Med-eBase select the Global Test Sequence icon 

or select Tools and then Global Test Sequence 

Select New 

 
 

Enter the sequence name and also the instrument  type. 
 

NOTE: Test sequences are for one instrument type only and therefore Med-eBase will not 
allow the user to mix tests from different Rigel devices (e.g. electrical safety and 
Electrosurgical). 

 
Select Add to insert a test or import to import an already created global test sequence into the    

new global test sequence. For the Uni-Therm test option are shown in the below   image. 
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The user can select multiple tests by holding ctrl when selecting and the order of selection is 
remembered in the sequence when OK is selected. 

 

 
 
 

 
 

Select  the Expand on  each  individual  test  to  change  the  test  setting  and  during  of  test  in 
the start all tests field. 
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After each group of simulations the start all tests must be inserted so that each simulation or 
change of settings has a set time for the Uni-Sim to recognise. 

 
 

Once the test sequence is complete select OK. 
 

To upload the test sequence into the Uni-Sim highlight sequence and select upload 
 

 

 
 

7.8. Test Templates for the Rigel Multi-Flo 
 

Please refer to Chapter 10 on remote control Multi-Flo for information regarding test templates for 
the Rigel Multi-Flo. 
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8. Test Certificates 
 

Med-eBase contains an automatic certificate generator which will produce either a paper certificate 
(print), or an HTML or PDF version for easy electronic storage and transfer. 

 
Highlight the relevant Asset and select the Test Results tab in the Asset Details view. Select the 
Print Certificate button from the side menu to create the test certificate for the selected Test 
Result. 

 

 
From here you can edit the Test Company and Client details before selecting either to Print or 

Save. 
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8.1. Med-eBase Multiple Print function 
 

The print function can allow for an individual asset result or multiple result certificates to be printed. 
Results certificates must meet certain criteria to be able to print multiple certificates: ❖ The same Instrument Type (e.g. 288 (+)) ❖ Assigned to the same client, in the asset browser, 

Select the first asset from the main asset browse screen ❖  

 
 

 
Press and hold ctrl to select additional assets. All selected assets should be highlighted. 
 

 

 

 

Then select the Print icon on the right hand side and select the Device type - the  generate  
certificate  menu  opens  to  allow  you  to  scroll  through  the certificates, set the template and 
add additional details etc. before  printing  or  saving  the certificates as PDF. 
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Please refer to application note 0051 Med-eBase and multiple print functions for further 
information of this process. 



Med-eBase Version 2.6 Instruction Manual - Revision   1.0     68 

 

 

8.2. Changing the Certificate Template 
 

To change the certificate template, open the drop down Template menu. 
 

 

The default choices are either the plain certificate or a blue themes certificate. These are both 
available in a range of languages. 

 
With a basic knowledge of HTML it is possible to further customise these test certificates. The 
certificate templates may be found in the Windows application data directory for all users (for 
example C:\ProgramData\Rigel\Med-eBase V2\Certificates). 

 
The saved file will then appear as a usable option in the Template drop down menu. 
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8.3. Inserting a company logo 
 

To insert your company/personal logo, select Browse. This will open a search window. 
 

 

Locate the logo file and select  Open. 
 

 

This will place your custom logo at the top of the test certificate. 
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8.4. Inserting an electronic signature 
 

To insert your electronic signature block, select Browse. This will open the search window. 

 

 
Identify the file containing your electronic signature and select Open to insert this into the test 

certificate. 
 

 

The signature will now appear in the signature area of the test certificate. 
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8.5. Customising Certificate Templates 
 

All certificates are located in: 
 

C:\ProgramData\Rigel\Med-eBase V2\Certificates\Templates. 
 

NOTE: Program Data may be a hidden folder and therefore you will need to go to 'Organize' 
and then to 'Folder and Search Options'. Select the 'View' tab and 'show hidden files and 
folders'. Click 'Apply' and then 'OK'. The program data folder should now be available to 
view. 

 
Within the certificates Template folder all available Tester Type Folders can be selected and     
within each is the different certificate types and languages e.g. Rigel 288_62353 (+) inside this is   
all the default and blue certificates for the electrical safety testers. 

 
The user can then copy a folder to customise or rename the certificate type most used so that it 
appears first in the list on Med-eBase. We advise that the new certificate needs to be renamed with 
a relevant name as this is what will appear on the dropdown list of certificate templates to choose 
from in Med-eBase E.g. Customised 
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NOTE: If the customised template folder is not renamed it could be overwritten when new 
versions of Med-eBase Software are installed in the   future. 

 

 

 
Select the copied folder and then open the file in either notepad or notepad++ to enable   editing. 

 
NOTE: Notepad ++ provides an easier layout to follow and is an open source program which can  
be download from the internet. 

 
The ONLY words that can be customised are shown with the character string "label"> :< /p>. 

Select Ctrl F to find the title which you want to customise. E.g. Test Protocol and enter the new 
phase is in between the arrows. On Notepad ++ changeable words are indicated in   black. 

 
NOTICE: On notepad ++ do not change any words in GREEN as this is information that 
comes from the Rigel tester. If this is changed the information will not be transferred from 
the results onto the certificate 

 

 

 
Once completed make sure the certificate has been saved.  Then open Med-eBase,  select the   
test asset you want to print and then select the print certificate icon. This takes  you  to  the 
certificate screen where the dropdown menu for templates should include your customised 
template. 
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Please refer to application note 0044 Customising Med-eBase certificate for further details of this 
process. 

 

 

8.6. Certificate Template Preference 
 

The latest certificate is remembered by Med-eBase the next time the user goes into the print 
certificate screen. However if the user does not have enough user admin rights this feature will    
not be able to write to the registry. 

 
If the user does not have admin rights they can go into the certificates  template folder (see 6.4)  
and remove the unnecessary languages or change the certificate name so that in  alphabetical  
order it becomes first on the list in Med-eBase.  There is also the option to customise certificates. 
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9. Data Export 
 

9.1. Production of an Asset Report 
 
The results stored in a database can be exported as a CSV file from Med-eBase. However, before 
creating the CSV file the data can be filtered, to do this, use the binoculars in the tools menu to 
display the search window. The Browse Assets window can be used to select a section of the 
database to be exported, for example assets by date tested or test date due: 

 

 

 

 

With your data filtered, if required, right mouse click on an asset and from the dropdown select 
Display Columns. 
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Selecting Display Columns produces a filter window which can be used to select the columns 
(data) that is required in the csv output. Select or deselect the options using the tick box and use the 
“Update and Close” button to save / close this window.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Selecting the Export Table to CSV icon (blue square with a green arrow) allows the Asset List to 
be saved as a CSV file.  
 
 
 
 
 
 
 
The format of the filename to be exported is "AssetList_<DATE>.csv", however, this can be 
changed if necessary. Browse for an appropriate location to save the file.  

 

 

 

 
 

 

 

Finally, the CSV file can be opened in a software programme, such as Microsoft Excel, to 
manipulate your data.  
 

Note; if using large numbers, for example a serial number without letters, spaces or other 
characters, if this CSV file is opened in MS Excel this can change the way the data is 
displayed (for example, 1234567890123 can be displayed as 1.234567E+12).  
To revert this back to the original format, in MS Excel, right mouse click on the cell (or data 
cells) and using “Format Cells…” change the format to “Number” and “Decimal places: 0”. 
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9.2. Exporting Multi-Flo Results 
 

 
The results downloaded from the Rigel Multi-Flo can be exported as a CSV file from Med-eBase. 
This will enable the user to manipulate and create graphs and trumpet curves from the raw infusion 
data. 

 
The format of the filename which is exported is "<ASSET   ID>_<DATE>_<TIME>.csv". 

 
It will export the last test result for the asset selected; this is because the export is located on the 
asset manager and not the result manager. The tests will be displayed horizontally with the data 
being displayed vertically. 

 
 

When results have been saved in Med-eBase the asset can be selected and then the user can 
select to export the raw data file in CSV format for specific analysis. 

 

 
 
 

Select a folder location to store the results. 
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The CSV file can then be opened in Excel from the selected location. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note; if using large numbers, for example a serial number without letters, spaces or other 
characters, if this CSV file is opened in MS Excel this can change the way the data is 
displayed (for example, 1234567890123 can be displayed as 1.234567E+12).  
To revert this back to the original format, in MS Excel, right mouse click on the cell (or data 
cells) and using “Format Cells…” change the format to “Number” and “Decimal places: 0”. 
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10. Remote Control Rigel Multi-Flo 
 

10.1. Gadget Serial 
 

To use the remote control mode the user will need to install the Gadget Serial V2.4 Driver. The 
driver should have accompanied your upgrade package and therefore the user will need to save   
the gadget serial folder either on their desktop or in an easy to locate destination of their choosing. 

 
Equipment required: ❖ Multi-Flo ❖ PC running Med-eBase  V2.4.0 (or above) ❖ Gadget serial driver install files ❖ USB Serial cable 

 
To install the gadget driver the Multi-Flo needs to be turned on and connected to the PC using the 
USB serial cable. 

 
On the Multi-Flo menu scroll down and select Remote Control. The Multi-Flo will then try to connect 
with the PC. 

 
The PC will attempt to download the install drivers for the gadget serial. As the driver are located   
on the PC and cannot be found on the internet this step is not required. Click on the icon when it 
appears as below. 
 

 
 
 

Select “Skip obtaining driver software” which is blue and underlined to stop widows looking for the 
driver as the Rigel device won’t be able to connect to the PC while the computer is performing     
this task. Select Yes on the driver software installation screen to skip the driver update. 

 

 

 

 

Once this is completed enter the Control Panel and go to ‘Devices and Printers’. The gadget serial 
will be an classed as an Unspecified Device. Right click on the gadget serial V2.4.0 and select 
Properties. 
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In the General Tab select Update Drivers and then choose ‘Browse my computer for driver 
software’. 

 
 
 

 

Select the folder where the gadget serial files are located.  Select Ok to choose the folder and then 
Next. 
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Once the driver is installed select Next and then close the Control Panel. 
 

 
 

To confirm the gadget serial driver is installed correctly: 
 

Open Med-eBase V2.4.0 (or above) making sure the Multi-Flo is connected and in Remote Control 
Mode. 

 
On Med-eBase select ‘Download from Tester’ by either selecting Tools > Download or the 
download icon. 

 
Choose Multi-Flo as the instrument type and then select Gadget serial as the COM port. 

 

 

 
NOTE: If Med-eBase was open while installing the gadget serial driver the user may be 
required to close Med-eBase and reopen it or Re-scan COM Ports to locate the gadget   
serial. 
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10.2. Creating Test Sequences 
 

10.2.1. Create an Asset ID 

 
Before connecting to the Remote control dashboard the user will need to create an Asset ID for 
the infusion device if there is not one already created. 

 

On the main Med-eBase screen select  ‘Add New Asset’ by either  the icon on the right hand  
side or Edit > Add New Asset. The Asset details section will now be available to fill   in. 

 

 
 

10.2.2. Connecting the Multi-Flo to Med-eBase V 2.4 (or 
above) 

 
Turn on the Rigel Multi-Flo and select Remote Control from the main menu. 

Connect the Multi-Flo to the PC using a USB serial cable. 

To run Multi-Flo remote control open Med-eBase V2.4.0 (or above) and select ‘Download from 

Tester’ in Tools > download or the . Chose the Multi-Flo from the dropdown instrument type 
list. 
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Then select the gadget serial as the COM port. If gadget serial port is not show you may need to re-
scan COM ports. Then select ‘Remote Mode Connect to COM port’. 

 
 

 
 

The Multi-Flo dashboard window will appear with details of the Multi-Flo and available channels. 
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10.2.3. Creating a Test sequences 
 

From the remote control dashboard the user can create Flow/Volume, Occlusion and PCA Tests   
on any available channel by firstly selecting the channel and then adding the appropriate test. 

 
Multiple tests can be inserted by clicking on Add test and the sequence order can be moved by 
dragging the test tabs to the desired location. 

 

 

 

 
 

NOTE: User Tests cannot be added to a sequence in the Multi-Flo Dashboard. This can    
only be inserted in the Global Test Sequence menu. 

 
The context menu allows the user to select multiple options for individual tests and sequences 
within the test set up: 

 ❖ Test Name’ is a single test configuration. ❖ ‘Sequence Name’ is a list of test configurations. ❖ ‘Import’ will load the test or sequence into the channel. ❖ ‘Export’ will save the test or sequence from the channel. 
 

 
To activate the context menu the user needs to be on the configuration test tab. Right click 
anywhere on this screen to show the context menu. 

 
This allows the user to edit, and copy Test sequences and tests between channels. 
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Individual Tests 
 

Each individual test configuration has a "Test Name" which can be overwritten to indicate the test 
name. 

 
Individual tests can be copied and paste into different channels or to repeat similar test set ups on 
the same channel. The user will need to add a test and then right click to open the context menu 
and select copy and then paste into the desired location. 

 
Individual tests can be removed by clicking on the [X] on the configuration tab.  

 

Test Sequences 

Test Sequence can be given unique names by entering the name in the "Sequence   Name" field. 
 

Test sequences can be exported into the main Global Test Sequence of Med-eBase. From here 
they can be used in the Multi-Flo dashboard, uploaded directly to a Multi-Flo unit or transferred to 
different PCs. The import function allows saved sequences from either the Multi-Flo dashboard or 
Global Test Sequence menu to be inserted into any   channel. 

 
NOTE: Only Multi-Flo test sequences can be imported into the remote control Multi-Flo 
dashboard 

 
The user can also create test sequences from the main Med-eBase window as a Global Test 
Sequence. Please see Chapter 5 of for more details on creating sequence in this   manner. 
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Flow/Volume Test 
 

The Rigel Multi-Flo is capable of measuring the instantaneous flow at a resolution between 10µL/hr 
to 1500ml/hr. In addition, the flow rate can be viewed based over  an  average  period  which is user 
selectable, as well as detecting peak and minimal flow rates on real time curves Instantaneous flow 
measurement gives the benefit of quicker test times at low flow rates with maintained accuracy. 

 

 

 
 

The test configuration tab allows the user to set the flow rate, back pressure, sampling windows and 
also upper and lower limits for the test which are specified by the manufacturer. 
The test duration can be based on time, volume or manual stopped by selecting the appropriate 
option from the dropdown list. 

 
The test can be given a memorable name in the ‘Sequence Test’ field so that it can be import or 
exported to create sequences. 

 
During testing instantaneous results are shown in the lower half of the screen and graphs can be 
viewed in the ‘Graphs’ tabs including accumulated volume, instant flow, average flow, pressure and 
trumpet curve. 
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Occlusion Test 
 

The Multi-Flo Occlusion test simulates an obstruction in the infusion process and monitors the 
variation in pressure due to the blockage. Most infusion devices have the ability to detect this 
obstruction and provide an occlusion alarm. The occlusion test is able to test this alarm feature in 
infusion devices. 

 
 

 
 
For the occlusion test the user must specify in the configuration tab whether the infusion pump has 
manual or auto rewind occlusion functionality. 
Enter the excepted alarm value and also the acceptable limits for the device under test. 

 
NOTE: There is a choice of units for pressure including mmHg, PSI, kPa and Bar. 

 
The test can be given a memorable name in the ‘Sequence Test’ field so that it can be import or 
exported to create automated sequences. 

 
During the test instantaneous results are shown in the lower half of the screen and graphs can be 
viewed in the ‘Graphs’ tabs including accumulated volume,   pressure and also tabulated values. 
If the infusion pump is manual then the user must ‘Stop’ the test when the alarm sounds to record 
the occlusion pressure level. 

 
For pumps which has auto rewind functionality when the alarm sounds the pump reverses the flow 
momentarily to relieve the occlusion and reduce the pressure. The test will stop and the results will 
display the maximum pressure at which the pump initiates the rewind function. 
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PCA Test 
 

The PCA test determines the additional volume delivered on top of the basal flow rate set by the 
user. The additional volume or sometime referred to as BOLUS, is an indication of the correct safety 
settings of an infusion device. The user needs to enter the basal flow as the basal flow rate setting 
is used to determine the additional volume being delivered. 

 
 
 

 
 
 
The test configuration tab allows the user to set the basal flow rate, bolus volume and total 
expected volume delivered during the test. The acceptable limits for the test will also need to be 
selected based on manufacturer’s specification. 

 
The test duration can be based on time, volume or manual stopped by selecting the appropriate 
option from the dropdown list. 

 
The test can be given a memorable name in the ‘Sequence Test’ field so that it can be import or 
exported to create automated sequences. 

 
During the test instantaneous results are shown in the lower half of the screen and graphs can be 
viewed in the ‘Graphs’ tabs including accumulated volume and instant flow. Tabulated results will be 
shown on the lower half of the screen following each bolus delivery and includes the bolus volume, 
the flow rate and the duration of the bolus and mean values for all bolus measurements. 

 
The user can carry out tests individual or as a whole test sequence. When conducting a single test 
select ‘Start Test’ and then select the Asset ID associated with the device being tested. The search 
criteria can be used to find the correct Asset ID scroll to select the asset ID. If an asset have done 
been created for this device then the user will need to add an asset in the main Med- eBase menu. 
See Chapter 9.2.1 for more details of creating   assets. 
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Once a test has started the Multi-Flo device will go to the appropriate test screen: Flow/Volume, 
Occlusion or PCA and the Elapsed Time field will indicate ‘Ready’ until the fluid enters the unit. 

 
NOTE: If an asset ID has not been created the user needs to go back into the Main Med- 
eBase window and create an Asset ID for this test. 
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10.2.4. Running a Test Sequence 
 

Once a test sequence has been created the user will select Start Test Sequence. When the 

sequence has started the screen with go to the first test in the sequence regardless of what screen 
the dashboard was in prior to starting the sequence. 

 
NOTE: The infusion device will need to be set up with the flow rate, bolus delivery details 
etc. matching the appropriate test set up created on Med-eBase. 

 
NOTE: The infusion device can be activated before or after the test is set up as the Multi-   
Flo will only start recording when fluid is delivered through to the device. 

 
The active test is indicated with a blue circle and all other tests are greyed out and cannot be 
altered during a test sequence. Other channels are available to set-up edit and start testing while 
the Multi-Flo is testing on another channel. 

 
 

 

 
The user can look at the real time graphs during each test.  More detail is provided in Chapter 
8.2.6. 

 
Once a test has completed the Multi-Flo Dashboard will show a confirmation that the test has 
completed and gives the user the options to: 

 ❖ Continue to the next test in the  sequence ❖ Exit sequence 
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If the user chooses to continue to the next test the Manger will move to the next test tab and    
again all other test tabs are greyed out and unavailable to edit. 
 

 

 
 
If the user selects No, to end the test sequence that the test sequence will stop and all tests will 
again become available to change. 
 

 
After the test sequence all tests will become available and each test tab will indicate whether the 
individual tests passed or failed. 
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10.3. During Testing 
 

The user can move between the configuration and graph tabs and toggle between the various 
graphs and tabulated results depending on the type of test. 

 
When a test is complete if it was time or volume based it will stop automatically 

 
For    manual stop tests the ‘Stop Test’ Button needs to be pressed to indicate the end of the test. 

 
If a test is stopped before either the time or volume in the setup has completed the user has the 
option to save the incomplete test results. 

 

 

 

 

 
In case of an emergency all channels can be stopped by selecting the RED button on the Multi-   

Flo Infusion Analyser. 

 
 
 

Flow/volume 
 

The user can toggle between instantaneous and average flow vs time graphs, which show the 
acceptable limits; the pressure during the test and also the trumpet curve showing the percentage 

error for the 2
nd 

hour of testing. 

 
The lower half of the test configuration screen shows the instantaneous results of instant, mean, 
min and peak flow (ml/h), total volume (ml), back pressure (mmHg) and error [instant or average 
flow or expected volume depending on set up  choice], 
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Occlusion 
 

The user can toggle between the pressure and the accumulated flow vs time graph, which shows 
the acceptable limit. 

 
The lower half of the test configuration screen shows the type of occlusion test carried out (manual 
or auto rewind) and the instantaneous results of: current peak pressure and back off pressure 
(mmHg) and bolus volume delivered once the occlusion has stopped. 
 

 

 
 
 

PCA 
 

The user can toggle between the pressure and the accumulated and instant flow vs time graphs, 
which shows the acceptable limits. The bolus can be clearly shown on the instant flow vs time 
graphs 

 
The lower half of the test configuration screen shows a bolus summary in tabulated format including 
average results of: mean volume, flow and duration as well as stats for each individual bolus 
measured. Test carried out (manual or auto rewind) and the instantaneous results of:  current peak 
pressure and back off pressure (mmHg) and bolus volume delivered once the occlusion has 
stopped. 

 
Test results information is also available including elapsed and remaining time, instant flow (ml/h) 
and total volume (ml). 
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Viewing graphs 
 

The user can toggle a full graph and 60 second default view by selecting the graph by single left 
mouse button click and you can then press the spacebar to toggle between the two options. 

 
The full data window will automatically scale the window using the full height of the graph to 
display the data. 

 
The 60 second window will automatically scale the window to track the data and keep the data 
within the window; this also includes the expected, lower and upper limits. 

 
On the graphs the user also has the options to do: 

 

 ❖ Scroll by holding the left mouse button down on the graph and drag up, down, left and right 

to scroll the graph. 
 ❖ Zoom in and out of the full data or a 60 second window: 
 

 
Double left mouse button click will zoom in and double right click will zoom out on the mouse 
cursor point on the graph. 

 
The user can draw around an area of interest and select CTRL and then hold the left mouse    
button down to create a range to zoom in. 

 
Mouse wheel enables zoom in and out of the graph. 

 
Hold the right mouse button down and push forward or pull back on the mouse to zoom in and out. 
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10.4. Reviewing Results 
 

Once the test is complete the user may close the dashboard window or view the results within the 
dashboard 

 
The test results can be view in the main Med-eBase software by selecting the Asset ID and then the 
Test Result tab. 
 

 

 

 
Within the test results tab the sequence will be shown as one item with a pass or fail status. All tests 
or sequences carried out under that Asset ID will be shown in the results tab. All items will have the 
test date and instrument type shown to indicate the testing carried   out. 

 
To view a particular test or sequence either double clicks on the item or select Results… from the 

right hand side of the asset details window. 

 

 
 

 
A progress bar may appear while the test results are created depending on the amount of data    
and test length. 

 
Expanding the test shows the summary of the test results, graphical results and when applicable 
tabulated data similar to the options available during testing. The pass or fail indication will be 
shown for each individual test within a sequence. 
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Flow Occlusion PCA 
 

 

 

 

Pass / Fail 
 

Once a test has completed the Med-eBase Multi-Flo Dashboard will indicate whether a test has 

passed or failed with a green flag icon or Red Cross in the tab for the specific test. 

 
If no limits are set then the test will automatically pass. The pass fail logic for each test type is 

defined as: 

 
 

Flow Volume ❖ The Error in configuration can be setup for Instant, Average and Expected. ❖ Instant flow is checked all the time and when the data is outside of the limits for more 

than 3 consecutive seconds it will be a fail. ❖ Average and Expected are checked on the last data value and outside of the limits it will 

fail. 

 
 

Occlusion ❖ Performed on the peak of the test if it is outside of the limits it will be a fail. 

 
 

PCA ❖ Performed on all bolus peaks of the test and if any are outside of the limits it will be a fail. 
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10.5. Exporting Multi-Flo Results 
 

The results downloaded from the Rigel Multi-Flo can be exported as a CSV file from Med-eBase. 
This will enable the user to manipulate and create graphs and trumpet curves from the raw infusion 
data. 

 
The format of the filename which is exported is "<ASSET   ID>_<DATE>_<TIME>.csv". 

 
It will export the last test result for the asset selected; this is because the export is located on the 
asset manager and not the result manager. The tests will be displayed horizontally with the data 
being displayed vertically. 

 
 

When results have been saved in Med-eBase the asset can be selected and then the user can 
select to export the raw data file in CSV format for specific analysis. 

 

 
 
 

Select a folder location to store the results. 
 



Med-eBase Version 2.6 Instruction Manual - Revision   1.0     97 

 

 
 

The CSV file can then be opened in Excel from the selected location. 
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11. Troubleshooting 
 

Please ensure you have the latest version of Med-eBase V2 installed. The latest version is available 
to download from www.rigelmedical.com. This will install over your current version without affecting 
your data or license keys. 

 
For technical queries, please email support@rigelmedical.com 

 

For sales enquiries, including purchasing additional licenses, please email sales@rigelmedical.com 

 
 

 
 

 


